
 

 
 

 

APPLICATION MANUAL 
 

 

 

SOFTWARE FOR FGX-295 

WAVEPATT 
 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

B71-0124-01 



CONTENTS 
 

1. Summary ........................................................................................................................ 1 

1-1. Method for install .................................................................................................................. 2 

1-2. Structure of this manual ........................................................................................................ 5 

2. Quick Start: Creating Waveforms ................................................................................. 6 

2-1. Create a New Waveform Edit Window .................................................................................. 7 

2-2. Built-in Wave Segments ....................................................................................................... 7 

2-3. Cut & Paste of Waveform Segments .................................................................................... 8 

2-4. Modify parameters of a Segment ........................................................................................ 10 

2-5. Pen/Line Mode ................................................................................................................... 11 

2-5-1. The Pen Mode Operation ............................................................................................. 11 

2-5-2. The Line Mode Operation............................................................................................. 12 

2-6. Limit Range with Y Markers ................................................................................................ 13 

2-7. Snip a Segment .................................................................................................................. 14 

3. Quick Start: Math Operations on Waveforms ............................................................ 15 

3-1. Calculation（＋、－、×） ....................................................................................................... 15 

3-2. Absolute, Invert and Mirror .................................................................................................. 17 

3-3. Clip ..................................................................................................................................... 18 

3-4. Smooth ............................................................................................................................... 19 

4. Quick Start: Interacting with FGX-295 ........................................................................ 21 

4-1. Send Waveform to FGX-295 ............................................................................................... 21 

4-2. Command Prompt .............................................................................................................. 22 

5. Reference ..................................................................................................................... 23 

5-1. Overview of the Main Window ............................................................................................ 23 

5-2. Waveform Edit Window ...................................................................................................... 24 

5-3. Toolbars .............................................................................................................................. 25 

5-3-1. Standard Toolbar .......................................................................................................... 25 

5-3-2. Waveform Operation Toolbar ........................................................................................ 27 

5-4. Menus ................................................................................................................................ 29 

5-4-1. File Menu ..................................................................................................................... 29 

5-4-2. Edit Menu ..................................................................................................................... 31 

5-4-3.View Menu .................................................................................................................... 34 

5-4-4. Math/Tools Menu .......................................................................................................... 35 

5-4-5. Connect Menu.............................................................................................................. 37 

5-4-6. Window Menu .............................................................................................................. 40 

5-4-7. Help Menu ................................................................................................................... 41 

5-4-8. Popup Menu ................................................................................................................ 41 

6. Pattern Out ................................................................................................................... 42 

6-1. Toolbar ............................................................................................................................... 43 

6-2. Edit Area ............................................................................................................................. 44 

6-3. Status Area ......................................................................................................................... 45 



 1 

1. Summary 

This application software enables to create on the PC, an arbitrary waveform that outputs from 

FGX-295. The created waveform is to be transmitted to FGX-295 through GP-IB interface, LAN 

or USB.  

 

［Operation environment］ 

OS : Windows 2000/ XP/ VISTA /7 (Install must be in administrator level) 

Interface : USB（1.0、2.0）,GP-IB（National Instruments Corporation GP-IB only is guaranteed）,  

 LAN 

Note: When using LAN, the driver (NI-VISA) will not be recognized automatically, therefore 

the setup must be done manually. 

 

To install driver and application, you must be administrator. Be careful that if you are not 

administrator, the install will not be correctly done. To log in with administrator, please ask your 

PC or Network administrator. 

 

［List of files］ 

Following execution files contains in the CD. 

Software name Usage 
Execution file name which 

contains software 

Wavepatt Application software for 
arbitrary waveform creation 

FGX-295 Wavepatt_setup.exe 

NI-VISA Run time NI-VISA Driver visa441runtime.exe 

※ Please be sure to install NI-VISA before executing Wavepatt_setup.exe. 

※ JAVA is essential to operate Wavepatt. This application will automatically search for 

existance of JAVA and if it does not exists, will obtain the latest JAVA through the internet 

when activating the application for the first time after install. Therefore, it is required to be 

connective to internet for first time activation. Also, there is no need to connect to internet 

after that. 

 

The latest version of this manual or each software may be downloaded from our web site  

（http://www.texio.co.jp）or from National Instruments web site （http://www.ni.com/visa）、 

JAVA（http://www.java.com/ja/） 

 

［Registered trademark］ 

Windows 、Windows 2000/ XP/ VISTA/ 7 is the registered trademark of Microsoft Corporation in 

USA and other countries. 

NI-VISA is the registered trademark of National Instruments Corporation.  

JAVA is the registered trademark of Sun Microsystems Inc.  

Besides, all indicated company or product name are their each trademark or registered 

trademark. 

 

http://www.texio.co.jp/
http://www.ni.com/visa
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1-1. Method for install 

STEP1（Driver install of NI-VISA） 

Following window will activate automatically after inserting application CD, so click ”NI-VISA Driver 

Software”. Then follow the instruction for the rest of install. Please open the "main.htm" within the 

CD by your Internet Browser if the window could not open. 

 

 

 

STEP2（Application install for FGX-295） 

Click "FGX-295 Application Software" from the initial window.  
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STEP3: Click ”Next” button. 
 

 

 

STEP4: Read license and if no problem click the button ” I Agree”. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

STEP5: Select the software to install then click ”Next” button. 
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STEP6: Select folder to install and click button ”Install” then install starts. 
 

 

 

STEP7: Please complete install by clicking “X (close)” button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

STEP8:  Please click “Finish” button.  
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STEP9: Execute program 

When install is correctly done, Wavepatt window will open executing the program. 

If install was not successfully made, application may not be executed, so please confirm  

again the status of each install. 
 

 

 

 

 

1-2. Structure of this manual 

This manual consists of two parts, one is “Quick start” which is focused only on the required point 

and the other one which explains all of the functions. Using “Quick start”, the creation of the arbitrary 

waveform up to registration to FGX-295 may be realized in a short period of time. Please refer 

following references for detail. 

Also, chapter 6 explains the detail for how to create parallel output waveform. 

 

・ Chapter 2 to 4 : Quick start（Method for creation of the arbitrary waveform ） 

・ Chapter 5 : References（All functions for arbitrary waveform creation） 

・ Chapter 6 : Parallel output waveform 
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2. Quick Start: Creating Waveforms 

Activating Wavepatt, a new waveform edit window will be displayed. 

The arbitrary waveform to setup on FGX-295 may be created in the waveform edit window. 

It is easy to create a complex waveform by combining a numbers of waveforms by adding an unit of 

waveform segment from the waveform edit window. The data displayed on one waveform edit 

window is treated as one waveform data so that storing a new arbitrary waveform data into the 

FGX-295 is possible by transmitting it to the FGX-295 which is connected by USB or GP-IB through 

the application. 

A basic waveform segments are already built-in (Built-in waveform segment) so that a new arbitrary 

waveform may be created by selecting them. Also using pen mode or line mode, an original 

waveform created by manual or line input is possible as well. 

 

Waveform window 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The horizontal axis of graph within the window means the point numbers which constitutes the 

waveform and the vertical axis is the value in the direction of voltage and the setup voltage (Vpp) 

when FGX-295 outputs corresponds to ±100. 

Between the two triangle marks（▼）at the top of graph indicates one segment. The triangle mark is 

usually red and the both ends of the segment will be displayed in blue. 

 

The waveform input will be made by one of the following method 

・ Select built-in waveform segment 

・ Manual input by pen mode 

・ Line drawing by line mode 

Waveform segment 
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2-1. Create a New Waveform Edit Window 

Users may create a new waveform by clicking the waveform button      in the standard toolbar. 

Users may also select the menu File>New Waveform or use the hot key "Ctrl + N" to do so. When 

users click the button, a new waveform edit window is created and the corresponding configuration 

dialog box is opened for users to change the related parameters for the waveform. 

 

 

Length : This is the length of the waveform in number of points.  

Name : A descriptive name given to the waveform. This is optional.  

OK/Cancel : Click the "OK" button to create the waveform or the "Cancel" button to exit from the  

 operation.  

 

2-2. Built-in Wave Segments 

Once the waveform edit window is created, users may add segments to the waveform by clicking on 

built-in segment buttons. The supported built-in segments are as following: 

 

Icon for built-in segment Additional waveform 

 
DC 

 
Sine 

 
Square 

 
Triangle 

 
Ramp 

 
Invert ramp 

 
Cardio wave 

 
Exponential fall 

 
Exponential rise 

 
Noise 
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2-3. Cut & Paste of Waveform Segments 

Copying segments from another existing waveform provides an easy way to create a new waveform. 

Users may do so by first selecting one or multiple segments and then selecting Cut or Copy under 

the Edit menu or clicking the corresponding buttons        on the standard toolbar to put the 

segments into the clipboard.  

To paste the segments from the clipboard, select Paste under the Edit menu or click the paste 

button      in the standard toolbar.  

Many operations in Wavepatt work on selected segments. Users may choose one of the following 

ways to select segments:  

 

Method of selecting the waveform segments 

The waveform operation in Wavepatt is made with segment unit. Following are method for selecting 

segment. 

 

1. Selecting one segment: 

Users can select a segment by double-clicking on it or drag the mouse over it. 
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2. Selecting consecutive segments:  

Users can select consecutive segments by dragging the cursor over the desired segments.  

 

 

 

3. Selecting multiple but non-consecutive segments:  

Users can press the Ctrl key while double-clicking a segment or drag over one or multiple  

segments to select multiple non-consecutive segments.  
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2-4. Modify parameters of a Segment 

To adjust the parameters of a segment, users may select a waveform segment and then perform 

one of the following two operations:  

 

1. Resize:  

Select Edit>Resize... to change the length and/or the amplitude of the segment.  

 

 
 

2. Configuration:  

This will allow to change all parameters of waveform segment. Click on     or select 

Edit>Configure a single segment... to bring up a configuration dialog, allowing users to change 

all the parameters of the selected segment.  

 

 

 



 11 

Waveform : Displays current segment. Change into other kinds is possible as well. 

Parameters : Displays each parameters of the segment. Setup close differs along with kind of segment.  

・ Length : Point number of X direction. Default value is 2000. 

・ Amplitude : Maximum amplitude to Y direction and the setup voltage correspond  

 to ±100%. 

・ Num Cycles : Cycle number that repeats waveform. Default and minimum value  

 are both 1. 

・ Phase : Phase of waveform at left end. Setup range is 0 to 360 and the  

 default value is 0. 

・ Y Offset : Offset voltage in Y axis direction and expressed with the same unit  

than the Amplitude.  

Waveform after offset will be a clipped waveform within the range of  

±100. 

Defaults : Returns all parameters to default value. 

OK : Shut the window completing setup. 

Cancel : Shut the window cancelling setup value. 

 

 

2-5. Pen/Line Mode 

Users can draw an arbitrary wave in two different modes: the pen mode (freehand) and the line  

mode. The pen mode allows users to draw any shape while line mode allows only a series of 

straight lines. The following instruction shows how to draw a waveform in these two modes.  

 

2-5-1. The Pen Mode Operation 

The method for adding a new waveform segment by free hand input (Pen mode) is described as below: 

 

1. Open an old waveform file with at least a wave segment. Or create a new one with at least a 

wave segment.  

2. Double-click on one wave segment to select it, or click and drag (or Ctrl + Double-Click) to 

select multiple waves or segments.  

3. Click the icon      or select Edit>Pen from the menu bar to enter the pen mode.  

4. Drag the cursor on the selected wave segment(s). The segments are changed instantly with 

the cursor movement.  

5. Once finished, click on the pen mode icon      again to leave the pen mode.  
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2-5-2. The Line Mode Operation 

The method for adding a new waveform segment constituted by a straight line 

 

1. Open an old waveform file with at least a wave segment. Or create a new one with at least a  

wave segment.  

2. Double-click one wave segment to select it, or click and drag (or Ctrl + Double-Click) to select  

multiple wave segments.  

3. Click the icon      or select Edit>Line from the menu bar to enter the line mode  

4. Click on the waveform to select the first end point of a line. Move the cursor and a line  

segment is shown with the mouse cursor as the other end point of the line. Click again to  

select the second end point and the line segment is settled down in the waveform.  

5. Now the second end point becomes the first end point of next line segment. Repeat step 4 to  

create a series of line segments. To finish the process, double-click a second end point when  

settling down a line segment, or right-click to cancel the current (unsettled) line segment.  

6. Click on the line mode icon      again to leave the line mode.  
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2-6. Limit Range with Y Markers 

Y markers can be enabled in the pen or line mode, or used to clip the selected segments within 

user-defined upper and lower limits. The following example shows how to modify waveforms or 

segments with the Y markers.  

To change the position of the Y markers, keep pressing the right button with cursor on the triangle 

mark at right end of marker then drug it. 

The method for changing the waveform segment using Y marker is described as below: 

 

1. Click the      button on the toolbar to enable Y markers. Two blue horizontal marker lines 

appear to indicate the upper and lower markers.  

2. Now in the pen or line mode, the drawing is limited within the area defined by the markers.  

3. Click the      button to disable Y markers.  
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Users may adjust the position of a marker line by dragging the blue triangle handle that appears on 

the right side of the marker line, with the right mouse button.  

 

2-7. Snip a Segment 

A segment may be cut in two halves if users want to select part of a segment. Selection is always 

aligned in segment boundary. The procedure is described below:  

 

1. Enter the snip mode by clicking      button on the standard toolbar, or select Edit>Snip from 

the menu bar.  

2. Move the cursor to the desired position in a segment.  

3. Click to cut the segment in two halves. (Notice the added segment boundary mark on top).  

4. Click the      button to leave the snip mode.  

 

 

Added snip point
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3. Quick Start: Math Operations on Waveforms 

Users may perform math operations on selected segments by selecting a function under the math 

menu or by clicking one of the buttons as below: 

 
Convert function Icon on 

menu bar 
Detail 

Waveform 
calculation 

（＋、－、×） 
 

Waveform calculation （ ＋ 、－ 、 × ）  is made for selected 

waveform and built-in segment 

Absolute value 

 

Convert is made so that selected each points of waveforms 
should be absolute value. As a result, amplitude below 0 level 
will be reflected in a positive direction. 

Invert 

（Up down reversed）  Selected waveform will be up down reversed. 

Mirror 

（Left right reversed）  Selected waveform will be left right reversed. 

Clip 
 

Combining with Y marker, selected segment waveform will be 
clipped within the selected range with Y marker. 

Smooth  Smooth the selected waveform using the moving average. 

 

3-1. Calculation（＋、－、×） 

Waveform calculation（＋、－、×） is possible on already input waveform segment and built-in 

segment. Below explains how to use calculation function. 

 

1. Select waveform segment that whish to waveform calculate. 

2. Click      button within the tool bar or select Math operation…within the Math menu. 

3. Following window will appear so select calculation kind and segment and click OK, then the 

calculation starts. 3 graphs within the window indicates select segment, calculation segment, 

segment after calculation. Please refer below for each closes of this window. 

 

 

A B

 



 16 

Each buttons and function of above window 

Part of Ⓐ： Setup the calculation to calculate. 

Part of Ⓑ： Select segment to calculate. Select from following. 

・None  : Waveform is not selected 

・Clipboard : Calculate along the waveform on the clip board. This close will not appear  

 if no waveform data on the clip board. 

・Newly Created : Calculate along the built-in waveform. Following window will appear so,  

  setup kind of built-in waveform and each parameter. Please refer chapter  

  2.4 for detail of the setup. 

Note: To change again the once input waveform or parameter, double click  

on the waveform input. 

 

 

 

Math Length : Adjust the waveform length to calculate (Waveform in center) in order to fit  

 to the point of X axis of the selected waveform (Left side waveform).  

 This function will be valid if check is in and if invalid, calculation will be  

 made up to the common points of two waveforms to calculate. 

Scale to Fit : Change the amplitude of waveform that automatically stays within the  

 range of -100 to +100. This function will be valid if check is in and the  

 waveform will be clipped within the range of -100 to +100 if invalid. 

 

(ex.1) For instance, users may add a noise waveform to a triangle wave. The resulting  

waveform would look like this:  
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(ex.2) Or users may multiply a single sine wave cycle by 50 cycles of another sine wave.  

And the resulting waveform would look like this:  

 

 

 

3-2. Absolute, Invert and Mirror 

The absolute math function converts all the points in selected segments to their absolute values. 

The invert function flips the selected segments about the time axis so that positive points become 

negative and vice versa. The mirror function flips the selected segments at the middle point of the 

selected segments along the time axis. Below is an example that illustrates the three operations:  

 

1. Select waveform segment that whish to change. 

2. Click below icons at tool bar or select each closes within the Math menu. 

・ Absolute value :       Icon 

・ Invert :       Icon 

・ Mirror :       Icon 

3. Corresponding convert for each function will be made. For example, if absolute value is  

assigned, the result is as following. 

 

(ex) Selected segment waveform                         Waveform after convert 

 

Absolute value
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3-3. Clip 

This function enables to clip the waveform level of already input waveform segment within the 

designed range. Select clip range by setup the upper and lower using the Y marker. Clip will be 

made enabling the clip function keeping this status. Below is the method for using clip function. 

 

1. Select waveform segment that whish to change. 

2. Enable Y marker clicking      button on tool bar and indicate the range to clip. (Refer chapter  

2.6 in Y marker) 

 

 

 

3. Apply the clip function by clicking the      button on the standard toolbar. The waveform will  

be clipped to the values specified by the Y markers.  
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3-4. Smooth 

This function performs a moving average on the points of the selected segments to smooth out the 

segments. Users may use this function to smooth out jitters in the waveform as large jitters in the 

waveform may cause unwanted frequency variations due to quantization error in the time axis. An 

example is given below.  

 

1. Select waveform segment that whish to change. 

 

 

 

2. Click the smooth function      on the standard toolbar to smooth out the waveform.  

 

 

 

Notes: By default, the smooth function performs a 9-points moving average. Users may change  

this setting by pressing the Ctrl key while mouse clicking the      button. This brings up  

a configuration dialog box as follows. Users may try different settings before making it  

effective. The number of points can be set from 3 to 199. Setup value and click Try button,  

then the waveform after convert will be displayed and RESET button will return to before  

the convert. Combining this function, value may be adjusted confirming the waveform.  

Click OK button, then this window will shut and smooth will be executed to the actual  

waveform. 
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Each buttons and function of above window 

Window Size : Setup the point number of the moving average. 

Tｒy : Multiply the moving average with the setup value of the waveform graphically  

 displayed. 

DEFAULTS : Return the point number of moving average to the initial value 9. 

RESET : Return to status before the multiplication  

OK : Make moving average to the real waveform with the setup value, then shut  

 the window. 

Cancel : Terminate window without making moving average. 
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4. Quick Start: Interacting with FGX-295 

4-1. Send Waveform to FGX-295 

The waveform data created with Wavepatt, may be sent to FGX-295 through USB, LAN or GP-IB 

and register it as an arbitrary waveform data. To send the waveform in the active edit window, click 

the      button or select Connect/Tools>Send waveform... from the menu bar. Users may specify 

parameters and then send the waveform and parameters to the FGX-295. For more information, 

please refer below for detail. 

 

Notes: The arbitrary waveform data sent to FGX-295 will be saved as Y direction in %and X 

direction by point’s number. The voltage value（Vp-p）which is set by turning the knob 

when output the transmit arbitrary waveform by FGX-295, correspond ±100％of Y 

direction for period (Frequency) and total points of X direction. 

 

 

 

Each buttons and function of above window 

Connect to : FGX-295 which is detected by NI-VISA will be list up, then select  

 FGX-295 to communicate. 

Waveform Name : Data name to store into FGX-295. Maximum 12 characters may be  

 input for alphanumeric. 

Use volatile memory : Checking this close, data will be stored into the volatile  

 memory(RAM). The stored data will be deleted after power off. 

Waveform Parameters : Display the parameter (Frequency, voltage, offset value) to transmit  

 to FGX-295. 
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Note: The setup value will be set temporary to the FGX-295 when the parameter is sent 

but it will be saved into the memory. Please be careful that waveform data sent at 

the same time will be saved as point number for X axis and % for Y axis. 

Send parameter only : Checking this close, parameter will be transmit without waveform data. 

LPF : Low pass filter will be made to delete the waveform jitter. 

Send : Transfer waveform data to FGX-295 and shut the window. 

Cancel : Shut the window only. 

 

4-2. Command Prompt 

Users may use a command prompt to send SCPI commands to FGX-295 and display corresponding 

responses. To bring up the command prompt, select Connect/Tools>Command Prompt... from the 

menu bar. The command prompt dialog box is described below. For more information on SCPI 

commands, please refer to the FGX-295 user's manual.  

 

 

 

Each buttons and function of above window 

1. Connect to : FGX-295 which is detected by NI-VISA will be list up, then select FGX-295 to  

communicate. 

Refresh : Confirm again the available interface to communicate. 

2. Display the command that received from FGX-295. 

3. Input the command to transmit. To transmit command, delete <Type command here> and  

input the command to transmit in place, then press Enter button. 

4. Clear Screen : Delete the received command 

Close : Terminate command transmit and shut this window. 
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5. Reference 

Each function of Wavepatt is explained here. 

 

5-1. Overview of the Main Window 

The main window includes four parts: (1) menu bar, (2) standard toolbar, (3) waveform operation 

toolbar and (4) the waveform edit window. Users can have several waveform edit windows opened 

at the same time in the main window, but only one is active at a time.  

①

②

③

④

 

The main window of Wavepatt is shown above. Each part of the graphical user interface is 

described as follows:  

 

1. Menu Bar: The menu style is similar to the standard Microsoft Windows R applications. For 

more information, please refer to section 5.4.  

2. Standard Toolbar: The standard toolbar provides quick access to useful functions from the  

menu, such as New File, Open File, Save, Cut, Paste, Print, Undo, Redo, Help, Pen Mode,  

Line Mode, Snip Mode, Y Markers, Toggle Tool, Smooth Tool, Clip Tool, Positive Invert Tool,  

Vertical Flip Tool and Horizontal Flip Tool. For more information, please refer to Section 5.3.1.  

3. Waveform Toolbar: The buttons of the waveform toolbar are for creating and editing the  

arbitrary waveforms. In particular, these buttons allow users to add/edit waveform segments in  

the active waveform edit window, change views, send waveform to connected instruments and  

so on. For more information, please refer section 5.3.2.  

4. Waveform Edit Window: The waveform edit window displays waveforms that are currently 

being edited. One window holds a waveform. Multiple waveform windows may be opened at a 

time. For more information, please refer section 5.2.  
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5-2. Waveform Edit Window 

Enable to create an arbitrary waveform window to transmit to FGX-295. One window is assigned 

to one arbitrary waveform data and the name of the window will appear upper left side. Following is 

the detail of each part of the window. 

 

 

 

 

Scale of the waveform edit window 

The initial setup for X,Y scale of the waveform edit window is as point number for X axis and % for Y  

axis. Scale may be changed to the combination of the voltage and second(cycle) by clicking       

icon on the tool bar. 

 

Note: The arbitrary waveform data sent to FGX-295 will be saved as Y direction in % and X direction 

by points number. The voltage value（Vp-p）which is set by turning the knob when output the 

transmit arbitrary waveform by FGX-295, correspond ± 100%of Y direction for period 

(Frequency) and total points of X direction. 

 

 

(ex.) FGX-295: 5Vp-p,1ms
 

5Vp-p

1ms

 

File name 

Display all 

Shut window 
Delimit of waveform 

One waveform segment 

(Waveform input unit) 

Time now 

Total data length 
Mouse position 

(X,Y axis & unit) 
Current mode 
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5-3. Toolbars 

There are two toolbars which enables to directly operate by only clicking on the icon which is useful 

for frequently used function. The upper one is the standard toolbar. The bottom one is the waveform 

operation toolbar. Following is the detail. 

 

5-3-1. Standard Toolbar  

The standard toolbar includes the following buttons.  

 

: To open a new waveform edit window. Multiple edit windows may be opened at one time. Refer  

2.1 for detail. 
 

: To open existing files. The files can be .WPT or .WPB files previously saved with the waveform  

editor or CSV files created from spreadsheet applications. Refer to Chapter 7 for supported file  

formats. 
 

: This button is used to save waveform data in the active waveform edit window. If the waveform  

has not previously been saved, the Save As... dialog box will appear and advices you to select  

a file name and format. 

 

 

 

: To copy selected segment(s) to the clipboard.  
 

: To remove the segment(s) from the active edit window and put the segment(s) to the clipboard. 
 

: To paste the waveform data currently saved in the clipboard to the active waveform edit window. 
 

: To undo the last action or command and revert to the previous condition.  
 

: To redo the action previously reverted by the undo action and restore the corresponding condition. 
 

: To bring up the help window.  
 

: To enter or leave the pen mode. In the pen mode, the cursor changes to a black cross when the  

cursor is inside the waveform edit window. Click and drag the mouse to draw the desired 

waveform shape in the selected area. Release the mouse button to complete it. To leave the 

pen mode, click on the button again. Refer 2.5.1 for detail. 
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: To enter or leave the line mode. In the line mode, the cursor changes to a black cross when the 

cursor is inside the waveform edit window. Click once at the desired starting point and move the 

cursor for the other end point of the line segment. Click again to settle down the line segment 

and the second end point becomes the first end point of the next line segment. Double-click a 

second end point when settling down a line segment, or right-click to cancel the current 

(unsettled) line segment. Click the button again to leave the line drawing mode. Refer 2.5.2 for 

detail 
 

: To enter or leave the snip mode. When in the snip mode, click on where to cut the segment in  

halves. Click the button again to leave the snip mode.  
 

: To enable or disable Y markers. When Y markers are enabled, users may adjust the Y marker  

position by using the right mouse button to drag the handle on the right of the marker line.  

To change the position of the Y marker, keeping the drug status by right mouse button on the  

triangle mark （▼）at right side then it enable to move up and down with the mouse. Refer 3.3  

for detail. 
 

: To apply the smoothing function to selected segment(s). Press Ctrl while clicking the button to  

bring up the configuration dialog box. Refer 3.4 for detail. 
 

: Add low pass filter(LPF) to the waveform in order to eliminate the jitter contained in the  

waveform. Click this close keeping the selected status of waveform segment, LPF(Cut off:100)  

will be added on the selected waveform. Also, the cut off frequency may be changed selecting  

it pressing Ctrl key. Please refer the detail with following: 

 

 

 

Each buttons and function of above window 

・ Cut Off Setup the cut off frequency of LPF. The setup value is 10 to 1000. 

・ Tｒｙ Added result of LPF will be displayed with the setup value made on right graph.  

 The result will not be reflected to the real waveform at this stage. 

・ DEFAUTLS Return the cut off frequency to initial value 100. 

・ RESET Return to the status before adding LPF. 

・ OK Shut the window after adding LPF with setup value. 

・ Cancel Shut the window without doing anything. 



 27 

: To clip the points outside the y markers on selected segments. Refer 2.7 for detail 
 

: To apply the absolute math function to selected segments. Refer 3.2 for detail. 
 

: To flip selected segments vertically about the time axis. Refer 3.2 for detail 
 

: To flip selected segments horizontally at the middle of the points of the selected segments  

along the time axis. Refer 3.2 for detail 
 

: Change the unit of Y and X axis of waveform edit window. X and Y axis will change to the  

combination of point number, %, Second, and voltage each time of click on Icon. Parameter  

change of second and voltage may be done at close of ”Set Parameters”. Refer 5.4.5 for detail. 

 

5-3-2. Waveform Operation Toolbar  

Within the function such as window add or display, transfer of edit data related to waveform edit 

window, waveform tool bar is aimed to execute in one click the frequently used functions. Below 

explains each button. 

 

: To enable the selection mode. It allows users to select a waveform area. This is the default  

mode when the program is started or a new waveform edit window is opened. 
 

: To add a new wave segment. A segment property dialog box will appear as follows. Refer to  

Section 2.4 for more information on how to use the dialog box.  

 

 

 

: To add a (DC, Sine, Square, Triangular, Sawtooth,  

Ramp, Sinc, exponential-fall, exponential-rise and noise) wave with default parameters. Press  

Ctrl while clicking the button to change the default segment length (Section 2.2).  
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: To bring up the math operation dialog box for performing math operations. Please refer to  

Section 3.1 for more information. 
 

: Use this button to control view of the displayed waveform area. Drag the cursor to show any  

part of the edit window. 
 

: To enter or leave the zoom mode. In the zoom mode, click and drag the cursor to zoom in the  

framed area. Right-click and drag the cursor to zoom. Click the button again to leave the zoom  

mode.  

 

 

 

 

Click

Drug up to here

 

 

: To zoom in the view area.  
 

: To zoom out the view area.  
 

: To "zoom to fit" the entire waveform in the edit window.  
 

: To bring up the segment property dialog (Section 2.4), which allows users to change the  

parameters of the selected waveform segment.  
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: To bring up the waveform sending dialog box (Section 4.1). It allows users to send the  

waveform to G5100A waveform generator.  

Note: When parameter is sent to FGX-295, setup value is temporary set but will not be stored  

into the memory. Please be careful that the waveform data sent with will be stored as point  

number for X axis, unit of % for Y axis. 

 

 

 

: To bring up the pattern out window. Pattern out is a standalone tool which allows users to send  

bit data (each datum with 16 bits per cycle) to connected G5100A. For more information,  

please refer to Chapter 6 Pattern Out.  

 

5-4. Menus 

Every function of Wavepatt is disposed within the menu bar along the kinds, and each function may 

be executed by clicking on it. 

 

5-4-1. File Menu 

The file menu has following functions. 

 

 

 

New waveform : Select this menu item or press the hot key Ctrl + N to create a new  

waveform edit window. This brings up the waveform property dialog box  

(Section 2.1) for setting up parameters of the waveform.  
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Open a waveform file : Select this menu item or press the hot key Ctrl + O to bring up an open-file  

dialog box. Users may select and open a previously saved data file.  

They can open .WPT and .WPB files previously saved with the waveform  

editor, or open a .CSV file created from spreadsheet applications.  

Save : Select this menu item or press the hot key Ctrl + S to save the waveform  

data in the active waveform edit window. If the file is to be saved for the  

first time, it works the same as "Save as" below.  

 

 

 

Save As : To bring up the "Save as..." dialog box so users may select a file name and  

format for saving the waveform data in the active edit window. 

 

 

 

Close : Select this menu item or press the hot key Ctrl + Q to close the active  

waveform edit window. 

Exit : Select this menu item or press the hot key Alt + F4 to exit the application. 
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5-4-2. Edit Menu 

The edit menu has following functions. 

 

 

 

Select : To enter the selection mode. In the selection mode, users may select one  

or multiple segments for various operations. This is the default mode when  

the program is started or a new waveform edit window is created. 

Pen : To enter or leave the pen mode. In the pen mode, the mouse cursor  

changes to a black cross as the cursor is moved inside the waveform edit  

window. Users may create free-style waveform segments in this mode.  

Refer 2.5.1 for detail 

Line : To enter or leave the line mode. In the line mode, the mouse cursor  

changes to a black cross as the cursor is moved inside the waveform edit  

window. Users may create piecewise line segments in this mode. Refer  

2.5.2 for detail. 

Snip : To enter or leave the snip mode. In this mode, users may cut a segment  

into two halves in any proportion. Refer 2.7 for detail. 

Add : To add a waveform segment to the active edit window. This opens up a  

submenu that lists waves including DC, sine, square, triangle, sawtooth,  

ramp, sinc, exponential fall, exponential rise and noise for users to choose  

from. Press Ctrl while selecting one of the items to change the default  

segment length (Section 2.2).  
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Enable Y markers : To enable or disable Y markers. Users may adjust y marker line positions  

when Y markers are enabled. To change the position of the Y marker,  

keeping the drug status by right mouse button on the triangle mark （▼）at  

right side then it enable to move up and down with the mouse. Refer 2.6  

for detail. 

Undo : Select this menu item or press the hot key Ctrl + Z to undo the last action  

or command and revert to the previous condition.  

Redo : Select this menu item or press the hot key Ctrl + Y to redo the action  

previously reverted by the "undo" action and restore the corresponding  

condition.  

Copy : Select this menu item or press the hot key Ctrl + C to copy selected  

segment(s) to the clipboard.  

Cut : Select this menu item or press the hot key Ctrl + X to remove the segment(s)  

from the active edit window and put the segment(s) to the clipboard.  

Paste : Select this menu item or press the hot key Ctrl + V to paste the waveform  

data currently saved in the clipboard to the active waveform edit window.  

Select all : Select this menu item or press the hot key Ctrl + A to select all waveform  

segments in the active edit window.  

Unselect : Select this menu item or press the hot key Ctrl + U to cancel the current  

selection of waveform segment(s) in the edit window.  

Set default segment length   : To open a dialog box which allow users to set the default segment  

length for adding built-in waveform segments. Setup will not change by  

clicking DEFAULTS button. 

 

 

 

Resize : To bring up a dialog box where users may change the length and the  

amplitude of a selected waveform segment. The segment length and the  

amplitude may be changed. Amplitude should be assigned with current  

status as 100%. 
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Expand to fit : To expand the current segments in length in order to fill up the entire  

waveform. 

Configure single segment   : Select this menu item or press the hot key Ctrl + F to change the  

parameters of the selected segment. Refer 2.4 for detail. 

 

 

 

Configure waveform : This enables to change segment length or data name of the already input  

waveform edit window. Selecting this close keeping the selection of the  

waveform edit window, following window will appear then setup the close  

that wish to change. Refer 2.1 for detail. 
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Set Waveform : While transmitting the arbitrary waveform to FGX-295, setup the voltage level,  

Parameters  offset voltage, frequency which will be transmit at the same time. Clicking this  

close, following setup window will appear then setup each closes and click  

OK button. The setup data will be displayed within the window for data  

transmit (Chapter 5.4.5 for detail). 

Note: The setup value will be set temporary to the FGX-295 but will not be saved as  

parameter of the waveform data transmit to FGX-295. 

 

 

5-4-3.View Menu 

The detail of the view menu is as following. 

 

 

 

Pan : To enter or leave the pan mode. In the pan mode, users may drag the mouse  

cursor to change the current viewing area in the active edit window. Icon will  

be pressed status when pan mode is valid and be invalid by pressing it once  

again. 

Pan Right : Select this menu item or press the hot key Ctrl + Right to move the waveform  

toward the right side. 

Pan Left : Select this menu item or press the hot key Ctrl + Left to move the waveform  

toward the left side.  

Pan Up : Select this menu item or press the hot key Ctrl + Up to move the waveform  
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upwards.  

Pan Down : Select this menu item or press the hot key Ctrl + Down to move the waveform  

downwards.  

Zoom : To enter or leave the zoom mode. In the zoom mode, users may zoom in or  

out of a specified area in the waveform edit window by mouse left or right  

button dragging over the area.  

 

 

 

 

Click

Drug up to here

 

Zoom In : Select this menu item or press the hot key Ctrl + Equal to zoom in the active  

edit window. 

Zoom Out : Select this menu item or press the hot key Ctrl + Minus to zoom out the active  

edit window.  

Zoom to fit : Select this menu item or press the hot key Ctrl + 0 to restore the view of the  

active edit window that covers the entire waveform. 

Connect Points :Delete the line substances of the waveform to the vertical direction. Select this  

menu item or Ctrl + L to connect or disconnect the points of the waveform in  

the active edit window.  

Refresh : Select this menu item or Ctrl + R to repaint the active edit window. 

 

5-4-4. Math/Tools Menu 

The detail of the Math/Tools menu is as following. 

 

 

 

Math Operation : Waveform calculates the already input waveform and selected waveform.  

Select this menu item or press the hot key Ctrl + M to bring up the math  

operation dialog box. Refer chapter 3.1 for detail.  
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Windowing : Select a window function from the submenu to apply that function to selected  

waveform segments. Note that users may press Ctrl while selecting Extended  

Cosine to bring up its configuration dialog box and the stretch size may be  

changed. The relation between each window function and the formula will be  

as following. 

 
Bartlett Window ω(χ)=1－2|χ－0.5| （0≦χ≦1） 

Blackman Window ω(χ)=0.42－0.5cos2πχ－0.08cos4πχ （0≦χ≦1） 

Extended Cosine ω(χ)= 2－(1＋(cos(0.5πχ / a))＊(step(a－χ))＋(cos(0.5π(1

－χ) / a))＊(step(χ－1＋a))) 

（0≦χ≦1、0＜a≦0.5) 

Hamming Window ω(χ)=0.53836－0.46164cos2π(χ （0≦χ≦1） 

Hann Window ω(χ)=0.5－0.5cos2πχ （0≦χ≦1） 

Triangular Window ω(χ)=1－2 / N＊cos(χ－（N－1） / 2） （N is Cycle Length） 

 

Extended cosine function setup dialog 

 

 

・ Stretch Size : Setup the stretch size. Setup range is 0 to 0.5. 

・ Tｒｙ : Graphical displays the result of the window function executed by the setup stretch  

size. At this time, the result will not be reflected to the real waveform. 

・ DEFAUTLS : Return the stretch size to initial value 0.1. 

・ RESET : Return the window function before the execution of window function. 

・ OK : Shut this window after execution of window function with setup value. 

・ Cancel : Shut the window without execution of window function. 

 

Smooth (+Ctrl) : To apply the smooth function to smooth out the jitters in selected waveform  

segment(s). Press Ctrl while selecting this menu item to bring up its  

configuration dialog box. Refer 3.4 for detail. 

 

LPF (+Ctrl) : Add low pass filter(LPF) to the waveform in order to eliminate the jitter  

contained in the waveform. Click this close keeping the selected status of  

waveform segment, LPF(Cut off:100) will be added on the selected  
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waveform. Also, the cut off frequency may be changed selecting it pressing  

Ctrl key. Please refer the detail with following: 

 

 

Each buttons and function of above window 

・ Cut Off Setup the cut off frequency of LPF. The setup value is 10 to 1000. 

・ Tｒｙ Added result of LPF will be displayed with the setup value made on right graph.  

The result will not be reflected to the real waveform at this stage. 

・ DEFAUTLS Return the cut off frequency to initial value 100. 

・ RESET Return to the status before adding LPF. 

・ OK Shut the window after adding LPF with setup value. 

・ Cancel Shut the window without doing anything. 

 

Clip : Works with Y markers enabled to cut out the wave points outside the Y markers.  

Refer chapter 3.3 for detail. 

Absolute : To apply the absolute math function to selected segments. Refer chapter 3.2 for detail. 

Invert : To flip selected segments vertically about the time axis. Refer chapter 3.2 for detail. 

Mirror : To flip selected segments horizontally at the middle of the points of the selected  

segments along the time axis. Refer chapter 3.2 for detail. 

 

5-4-5. Connect Menu 

The connect menu has the following functions as shown below.  

 

 

 

Send waveform : To bring up the waveform sending dialog box (Section 4.4.5). Users may  

configure in this dialog box to send the waveform data in the active waveform  

edit window to connected arbitrary waveform generator. Refer chapter 4.1 for  

detail. 
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Note: The setup value will be set temporary to the FGX-295 when the parameter is sent but it 

will be saved into the memory. Please be careful that waveform data sent at the same 

time will be saved as point number for X axis and % for Y axis. 

 
 

Manage waveforms on device  : To bring up a dialog box for managing stored waveforms and  

output selection on connected arbitrary waveform generator. Clicking this  

close, following window will open and the list registered into the FGX-295 will  

be displayed. The waveform name with ＊ is a fixed data and therefore may  

not be deleted. It will be deleted when clicking “Delete” button selecting the  

data within the list, and selected as a output waveform when clicking  

“Output” button. Below is the detail of each windows. 

 

 

 



 39 

Each buttons and function of above window 

・ Device FGX-295 which is detected by NI-VISA will be list up, then select FGX-295 to  

communicate. 

・ Refresh Confirm again the interface capable to communicate. 

・ Output type Select the way of FGX-295’s output from arbitrary waveform（Arb Ex）or parallel  

out（Pattern Out）. 

・ Output Select waveform data to output from FGX-295. 

・ Delete Deletes arbitrary waveform data registered to FGX-295. The waveform name  

with ＊ is a fixed data and therefore may not be deleted. Also, the arbitrary  

waveform or parallel output selected by FGX-295 may not be deleted as well. 

 

Pattern Out : To bring up the pattern out window. Pattern out is a standalone tool which  

allows users to send bit data (each datum with 16 bits per cycle) to connected  

FGX-295. For more information, please refer to Chapter 6 Pattern Out.  

Command prompt : To bring up the command prompt window that allows users to send SCPI  

commands to connected FGX-295 and receive responses. For more information  

on SCPI, please refer to Chapter 4.2 Waveform Output Operations of the  

FGX-295 user's manual.  

 

 

 

Import : Users may select a submenu item to import files which were output from other  

types of devices such as TEXIO DCS-7500serise or the Agilent oscilloscope. 

The Wavepatt convert the biggest amplitude level of a waveform data of the 

oscilloscope as 100% level. Please note that the data of a time axis and a 

vertical axis in the oscilloscope is not succeeded. 

The supporting file format is a CSV waveform data made in the TEXIO 

DCS-7500 series or the Agilent oscilloscope. Please refer the detail with 

following as data convert methods are different. 
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Import from the TEXIO DCS-7500serise 

The kind of the wave pattern of the DCS-7500 series is two kinds in the 

difference of the CSV format such as "Detail" or "Fast", but Wavepatt converts 

it automatically. 

The difference of the number of the data points is three kinds, and the 

Wavepatt just reads the 4k size data, but 1M or the 2M size data compress it 

and read. When it read 1M, 2M data, the following screen appears and 

chooses a data compression method among "peak Detect" or  "regular 

interval". 

 

Import from the Agilent oscilloscope 

Users may select a submenu item to import files which were output from the 

Agilent Oscilloscope, and the close of “Agilent MS08104” should be selected 

what ever the product’ kind is. Also, only CSV file is accepted and, the check 

box "Include scale factors" must be checked. Oscilloscope must be checked 

while storing a waveform file.  

(Operation confirmation is made only with Agilent’s MS08104 for this function.) 

 
5-4-6. Window Menu 

The closes related to the operation of waveform edit window are put within the menu.  

 

 

Windows list

 

 

Switch to Next Window : Select this menu item or press the hot key Ctrl + W to switch the  

active edit window to the next one in the window list. 

Switch to Previous Window : Select this menu item or press the hot key Ctrl + Shift + W to  

switch the active edit window to the previous one in the window list. 

Arrange All Windows : To arrange all the edit windows according to the order in the window  

list.  
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Maximize All Windows : To maximize all the waveform edit windows.  

Restore All Windows : To restore all the maximized windows to their original sizes. 

Window list : Select a window in the list to switch the active edit window directly  

to the selected one. 

 

 
5-4-7. Help Menu 

The closes related to the help function or Wavepatt are put within the menu.  

 

 

 

Help : Displays help in English 

About Wavepatt : To get the about information of Wavepatt. 

 

5-4-8. Popup Menu 

Right click the mouse within the edit window, a popup menu which contains a list of function 

frequently used will be list up. Selecting from the displayed menu, each function will be easy to use. 

Each function are equal to menu bar function. Refer chapter 5.4.2 for detail. 
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6. Pattern Out 

The pattern out function is a standalone tool which can send bit data (each datum with 16 bits per 

cycle) to the FGX-295. It can be easily accessed in Wavepatt by either clicking the button on the 

waveform operation toolbar  or selecting Connect/Tools>Pattern Out from the menu bar. 

Following is the detail of each function. 

 

 

①

②

③

 

 

Each buttons and function of above window 

1-Tool bar : Functions related to waveform creation are in icon that just to click on it to  

execute. 

2-Edit area : Area for waveform creation. 

3-Status area : Display and setup of each parameter for waveform creation. 
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6-1. Toolbar 

 

: Open an existing file. 
 

: Save the data to file. 
 

: Zoom in along the time axis 
 

: Zoom out along the time axis. 
 

: Select a point for the display to start with. A dialog box will appear as shown below. Users may  

input a value from 0 to 262144. 

 
 

: Invert the selected bits or samples. Click waveform on edit area to invert edit area. Valid and  

invalid will change vise versa each time of click on icon. 
 

: Pull high on the selected bits or samples. Keeping the valid status by click of icon, click on  

waveform on edit area then the clicked waveform will be high level. Valid and invalid will  

change vise versa each time of click on icon. 
 

: Pull low on the selected bits or samples. Keeping the valid status by click on icon, click on  

waveform on edit area then the clicked waveform will be low level. Valid and invalid will change  

vise versa each time of click on icon. 
 

: Send the programmed data to FGX-295. A dialog box appears before the data is sent to the  

instrument. It allows users to select a desired instrument to send data to and specify a name for  

the pattern. 

 

 

・ Connect to Select a desired waveform generator to interact with. If the drop-down list does  

 not display correct instruments or incorrectly shows "No device available". 

・ Refresh Re-detects the connected instruments. 

・ Pattern Name To specify a name for the pattern data. Data will be stored into the same  

memory area than the arbitrary waveform within the FGX-295. 

・ Use volatile memory This checkbox decides whether waveform sending to non-volatile memory  

or not, if checked then waveform is in volatile memory only. If a new  

arbitrary waveform data is stored, the already registered pattern out will be  

deleted by overwrite. 

・ Send Transfer the data and shut the transfer window. 

・ Close Shut the window without transfer. 
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6-2. Edit Area 

The edit area allows users to edit the pattern. The default value on the bit time lines is low. The 

default action when clicking on a bit is to invert it. Users may click the "pull high" or "pull low" button 

to change the action. 

 

 

 

Method for selecting edit unit 

Single selection : Single click on a bit to apply the action directly on the bit. 

Area selection : Drag the cursor to select an area of bits. The selected bits are changed  

to blue.  

Bit number selection : The bit number buttons on the right allow users to select a specific bit  

along the entire time axis. The selected line is changed to blue.  
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6-3. Status Area 

The area shows the window's current status. Any modification on the parameters in the status area 

affects the edit area instantly. The description is given below.  

 

Cursor at : It shows the cursor location along the time axis.  

Current Bit : This show the bit number (from 0 to 15) where the mouse cursor is located.  

Bits / Pixel : Represents the number of bits contained in a pixel. The maximum value is  

512. When the edit area is zoomed out to one bit or more in a pixel, the label  

is enabled; disabled otherwise.  

Pixel / Bit : Represents the number of pixels contained in a sample. The maximum value  

is 25. When the edit area is zoomed in to one pixel or more in a bit, the label  

is enabled; disabled otherwise.  

Clock Frequency : Setup the frequency of clock signal for pattern out. The setup value will  

temporary be setup as the setup value of the frequency when pattern out is  

transmit. Note that the pattern out waveform stored in FGX-295 will not be  

registered as parameter of frequency. The setup value will be deleted when  

frequency is changed with FGX-295 or power off. 

Latch Slope : Setup the edge when making data latch based on clock signal. 

Current Operation : Indicates the waveform input method for selected waveform. Waveform input  

method will be setup by the icon of the tool bar and its relation will be as  

following. 

 
Icon of tool bar Display 

 
Inverse 

 Pull High 

 Pull Low 

 

Access Length : Setup the data number of transfer (16bits length as 1 nit). Setup range is form  

1 to 262144 and the default value is 262144. 



 

 

  

 

 
7F Towa Fudosan Shin Yokohama Bild. 
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